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Introduction 
 

Ham Radio Deluxe is a suite of programs designed to provide everything the avid amateur radio 
operator needs all in one package.   

Rig Control,  Logbook,  Digital Modes,  Rotor Control, and Satellite Tracking are all built into the 
software.  Each module has its own sub-set of features and all modules are designed to 
communicate with each other so total integration is achieved. 

Although the different modules in HRD can be run separately, to take full advantage of the 
power and versatility built into the software, it’s best to run the entire suite. 

Minimum System Requirements 
HRD is an advanced program with the latest in database and information management. 
Because of the large amount of storage and memory that the software uses, a certain minimum 
level of hardware support is needed.  Essentially the rule is, the older and smaller (in storage) 
the hardware, the slower the database and lookups will operate. Also, very large databases will 
slow down storage. 
 
Notes: HRD will NOT run properly on Windows 2000 or any 16bit version of Windows such as 
Win95/98/ME. 

Minimum System Requirements 

                    Windows XP SP3                                                            Windows 7 
                    1GB RAM Memory                                                          4GB RAM Memory 
                    10GB unused hard drive storage                                 50GB unused hard drive storage 
                    Pentium 5 (P5) Processor                                               Dual Core Processor 
                    1024x768 256 color display                                           1920x1080 Hi-Color display 

Another very important requirement, especially for Rig Control, is a quality connection between 
the computer and the radio.  Different radio manufacturers have different requirements as far 
as cables to connect their radios to a computer CAT control.  Its best to check your radio user’s 
manual to determine the proper cables and connection requirements.   

In general most radios require an RS-232 connection at the computer end.  Most computers 
today do not come equipped with RS-232 ports.  If you are using a desktop computer it is to 
your advantage to purchase an RS-232 card and install it in your computer.  They can be found 
on E-Bay for around $15.00, give or take.   

For those who use laptops or computers where you can’t install an RS-232 card you will have to 
have a good quality USB/Serial converter.  Here’s where things can get interesting.  There are 
many of these converters available that are very inexpensive.  A word to the wise…STAY AWAY 
FROM THEM.  The problem is a few years ago the market was flooded with counterfeit Prolific 
chip sets.  Many of these chip sets were used to build these inexpensive converters and the 
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drivers were poorly written.  According to the Prolific website the company has recently started 
BRANDING products with legitimate Prolific chip sets.  They are marked with the Prolific logos, a 
part number and serial numbers and other information that identifies the parts as genuine. 

Ham Radio Deluxe however puts an extremely heavy load on the RS-232 ports and have found 
that cables and converters with the FTDI chip sets seem to work best.  These products are 
extremely reliable and it is recommended you use a cable or converter that has this chip set. 

You can check on the HRD Software LLC website to find dealers where you can purchase these 
cables and converters, or they are available on E-Bay, and many DO advertise the use of the 
FTDI chip sets in their products. 

Supported Radios 
Ham Radio Deluxe supports over 80 radios from major manufacturers.  The following is a list of 
currently supported models. 

Elecraft 
K2, K3,KX3 (in K3 mode) 
 
FlexRadio 
PowerSDR 
 
ICOM 
IC-7000, IC-703, IC-706, IC-706MkII, IC-706MkIIG, IC-707, IC-718, IC-7200, IC-725, IC-726, IC-
728, IC-729, IC-7200, IC-735, IC-736, IC-737, IC-738, IC-7400, IC-746, IC-746Pro, IC7410, IC-751A, 
IC-751A (Piexx), IC-756, IC-756Pro, IC-756ProII, IC-756ProIII, IC-7600, IC-761, IC-765, IC-7700, IC-
775DSP, IC-7800, IC-9100.IC-781, IC-821H, IC-910H, IC-R10, IC-R20, IC-R7000, IC-R75, IC-R8500, 
IC-R9000, IC-R9500 
 
ICOM 
PCR-1000 
 
Kenwood 
R-5000, TS-140S, TS-2000, TS-440S, TS-450S, TS-480, TS-50S, TS-570, TS-590, TS-60S, TS-680S, 
TS-690S, TS-790, TS-850, TS-870, TS-940S, TS-950, TS-B2000 
 
Microtelecom 
Perseus 
 
SDR-RADIO 
 
Ten-Tec 
Argonaut, Jupiter, OMNI VII (Radio), OMNI VII (Remote), Orion, RX-350, Eagle 
 
Yaesu 
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FT-100, FT-1000D, FT-1000MP MkV, FT-600, FT-817, FT-840, FT-847, FT-857, FT-890, FT-897, FT-
900, FT-920, FT-990, FT-2000, FT-450, FT-950, FTDX-5000, FTDX-9000 

Although your radio appears on the supported list not all functions on some radios are available 
to be controlled via CAT.  The available functions for a particular radio may be limited due to 
the command set installed in the radio by the manufacturer. 

Getting  Started 

The first step in getting started with Ham Radio Deluxe is to install the software.  If you 
purchased Ham Radio Deluxe from a vender or hamfest, insert the CD in your computer to start 
the installation process.  If you have not yet gotten a copy of Ham Radio Deluxe you can 
download the latest version from the HRD Software website at www.hrdsoftwarellc.com. 

If you have not yet purchased Ham Radio Deluxe, you can still download the latest version from 
the website.  Once you run the program and are presented with the registration screen, if you 
are connected to the internet, just type in your callsign and hit OK and you will automatically be 
granted a 30 day trial license.  If you ARE NOT connected to the internet, the trial period is 
seven (7) days. 

 

Registering HRD 

When you first install and start Ham Radio Deluxe you will see the software registration screen.  
The following is a step by step procedure to register HRD if your computer is not connected to 
the Internet. These are step by step instructions to insure you will be able to get your software 
up and running the first time you try. 

Manual Registration 

MANUAL REGISTRATION/NO INTERNET CONNECTION 

 

On the above screen enter your callsign in the lower field and press OK 

http://www.hrdsoftwarellc.com/
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On this next screen click on the Manually Add Key or Serial button. 

 
Now you will come to the window where you enter your license key. If you do not have this key, 

please send an e-mail to key@hrdsoftwarellc.com to request a key. 

 

file:///C:/Users/KB3NPH/Documents/HRD%20V6%20Rig%20Control%20Manual/k
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After you have typed or copied and pasted your key, click on OK. 
 

You will now at the Welcome Screen. If you see the Warning message indicating the Serial 
Number is Invalid, click on the Resubmit Serial Request button. 

 

A serial number will appear in the System Serial Number box and you are ready to click on the 
Continue button. 
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Clicking on the Continue button will take you to the Radio Setup screen in Ham Radio Deluxe. 

Internet Registration 

This next section will cover the registration for those who DO have an internet connection. 

After installing and running the Ham Radio Deluxe software you will see the following screen.  
Enter your callsign and click OK. 

 
On this next screen click the New Key Request button. 
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You are now at the screen where you again enter your callsign and your purchase key, which 
you should have received by e-mail.  If you haven’t received this key please send an e-mail to 
key@hrdsoftwarellc.com to request a key. 

 

Once you have entered your callsign and purchase key, click on the OK button. 

The Welcome Screen will now return and if you see a Warning Serial Number is Invalid 
message like the one below, click on the Resubmit Serial Request Button. 

file:///C:/Users/KB3NPH/Documents/HRD%20V6%20Rig%20Control%20Manual/k
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A  new serial number will appear in the System Serial Number box. You are now ready to click 
on the Continue button at the bottom. 

 

 

Once you have clicked the Continue button you will be presented with the Ham Radio Deluxe 
radio setup screen. 
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Radio Setup 

If you haven’t done so yet, shut down your computer and connect your cables from the 
computer to the radio.  Turn on your radio and re-start your computer.  The next screen you 
should see is the radio connection setup screen.  This is where you select your radio and set 
some parameters to allow the HRD Rig Control software to connect to your radio. 

Select Radio 

 

Radio Setup Screen 

Company 
Select your radio manufacturer from the drop-down list. The Dem-o-Matic radios do not 
require a COM port, they are for demonstrating HRD when you do not have a suitable radio 
available. 
 
FlexRadio: you must install the virtual serial port drivers from Philip Covington (N8VB). These 
are used to provide the connection between HRD and the PowerSDR sofware which must be 
running before you try to create the connection with HRD. More information is available from 
http://www.flex-radio.com/. 
 
ICOM: disable the CI-V Transceiver option for best performance. 
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Kenwood: make sure Packet communication mode is switched OFF (if supported). Most 
Kenwood radios require CTS and RTS to be ON for flow control. 
 

Select Your Com Port 
Select your radio model from the drop-down list. 

 

COM Port 
The COM port on this computer where you have connected the radio interface cable.  Make 
sure that you do not have other programs using the same port.  It is recommended you NOT 
use the Auto-Detect.  The Auto-Detect  can sometimes fail to detect the port. 
 
 

Speed 
The speed used for communicating with the radio, check the speed setting via the radio's 
configuration menu.   Again, it’s not recommended to use the Auto-Detect.  Also remember 
that “FASTER IS NOT ALWAYS BETTER”.  Sometimes faster speeds can cause timing problems 
when sending commands back and forth between HRD and the radio.  The important thing is 
that you set the speed in HRD and the port speed in the radio the same.  Check your radio 
manual to find out how to set the com port speed. 
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Select Flow Control 
CI-V Address 
ICOM only:  the address assigned to the radio, consult the radio's manual for the default 
address.  This can also be configured via the radio's configuration menu.  A list of default 
addresses can be found at the end of this section. 
 
CTS 
Enables the CTS flow control, required for Kenwood radios. 
 
DTR 
Enables the DTR line when the COM Port is opened and leaves it on, usually to provide power 
for an interface cable. For Yaesu CT-62 and ICOM CT-17 interfaces this can be left unchecked 
(off). 
 
RTS 
Enables the RTS line when the COM Port is opened and leaves it on, usually to provide power 
for an interface cable. For Yaesu CT-62 and ICOM CT-17 interfaces this can be left unchecked 
(off). 

Next, put a check in the boxes for DTR and RTS.  Some radios don’t require both of these 
settings checked so they can be unchecked if there is a failure to connect to the radio. 

If you will be connecting more than one radio to HRD and you would like the current one to be 
the default radio, place a check in the box where it says “Always connect to this radio when 
starting HRD Rig Control”. 

On the lower part of the setup panel you see several other options.  You can select to have HRD 
start in the FULL SCREEN mode by putting a check in the box.  You will also see a group for Auto 
Exit.  These options are not yet implemented in V6.0.  There is also check boxes to allow the 
other modules in the HRD suite to start when the Rig Control is started.  It isn’t necessary to 
auto-start all of the modules.  They can be started from within the different displays. 

Default CI-V Addresses (ICOM) 
04 = IC-735    06 = <unknown>   08 = R7000 
10 = IC-275    12 = IC-375    14 = IC-475 
16 = IC-575    18 = IC-1275    1A = R71 
1C = IC-751A    1C = IC-IC-751A (Piexx)  1E = IC-761 
  20 = IC-271     22 = IC-471    24 = IC-1271 
  26 = IC-781     28 = IC-725    2A = R9000 
  2C = IC-765     2E = IC-970    30 = IC-726 
  32 = R72     34 = R7100    36 = <unknown> 
  38 = IC-728     3A = IC-729    3C = IC-737 
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  3E = IC-707     40 = IC-736    42 = IC-820 
  44 = IC-738     46 = IC-775DSP   48 = IC-706 
  4A = IC-R8500    4C = IC-821H    4E = IC-706MkII 
  50 = IC-756     52 = IC-R10    54 = <unknown> 
  56 = IC-746     58 = IC-706MkIIG   5A = IC-R75 
  5C = IC-756Pro    5E = IC-718    60 = IC-910H 
  62 = IC-78     64 = IC-756ProII   66 = IC-746Pro 
  66 = IC-7400     68 = IC-703    6A = IC-7800 
  6C = IC-R20     6E = IC-756ProIII   70 = IC-7000 
  74 = IC-7700 

If you are sure everything is set properly on this screen your ready to click the CONNECT icon 
(the little green box with the arrow in it).  If all settings are correct the next screen you should 
see is the main HRD Rig Control display. 

Problem Solving 
Windows returns the error 'Access Denied' when the COM port is held open by another 
program. 
 
If the frequency is showing random values make sure you have actually connected to a radio 
and not to another device connected to you PC such as a PDA or mobile phone. Also look at the 
USB <=> serial converter issues below. 
 
Check the baud rate. 
 
Check that a CI-V interface (ICOM) or special Yaesu cable such as the CT-62 is receiving power 
from the COM port, normally by selecting DTR and/or RTS. 
 
If you are using a USB <=> serial converter then: 

 Make sure you have installed the latest manufacturer's drivers, 

 Not all USB <=> serial converters can handle the load from modern control software. 
 
If you are using a USB hub: 

 Make sure it is a powered hub (has its own power supply), otherwise it may not be able 
to provide enough current to power the converter. 
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Dem-O-Matic 

 

A nice feature included in the setup panel is known as the Dem-o-matic mode.  This mode 
simulates having an actual radio connected to the computer and controlled by HRD. 

In the Company drop-down box select the last option which is Dem-o-matic.   In the Radio drop-
down menu select any one of the radios available. 

When you press the connect button in the Dem-o-matic mode,  HRD will start and operate just 
as if there were a radio connected.   

You will be able to log QSOs in the logbook or if you have an audio interface such as a SignaLink 
or similar connection between the computers soundcard and the radio you will be able to 
operate in the digital modes.  The only thing that would not function is the Rig Control.  You 
would have to set frequencies and modes on your radio manually and adjust the DEMO radio in 
HRD to match frequency and mode for logging purposes.   
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HRD Rig Control 

 

HRD Rig Control Screen 

Once everything is configured properly in the Radio Setup Panel and the HRD Rig Control 
software is able to connect to your radio you will be presented with a screen similar to the one 
in the above illustration.  Your display may differ somewhat depending on the which radio you 
are using and the radio controls that are available for CAT control.  In this manual we are using 
a Yaesu FT-857D. 

 

Rig Control Toolbar 
At first glance the HRD Rig Control screen looks very complicated.  In reality, once you start 
using it you will find it is quite simple to navigate around.  The toolbar is actually divided into 
several sections and is very customizable.  We will break it into sections and explain what each 
icon and command does. 

Placing your cursor on a blank portion of the toolbar and right clicking 
brings up a menu that allows you to customize the icon toolbar or even 
hide parts or all from view.  We will now remove the check marks from 
the Program and Logbook portions and take a close look at only the 
Main icon toolbar. 
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Main Toolbar 
Actually there are two toolbars displayed here.  We have a Text Menu across the top and the 
icon toolbar under the Text Menus.   

Starting from the left, clicking on the Connect icon brings up the Connect Panel.  This is where 
we configured our radio and connections to the radio when first installing the HRD software.   

The next Selection icon opens a panel that can be pinned to the Rig Control display and 
contains many of the features and data managers used in the Rig Control program.   

The Favorite icon opens a window that allows you to create and save new folders in your 
Favorites list.  We will talk about that a little later.  For now we will just say that if you do create 
a new folder you need to enter at least one frequency in it,  at the time of creation, or it will not 
be saved when you exit the window.   

If you’re listening to an interesting frequency, it could be a net, a short-wave broadcast or just 
about anything and you would like to hold onto the frequency, clicking on the Quick Save icon 
places the frequency in a special data file where you can retrieve it later.   

The Full Screen icon expands the default view to a full screen view.  Pressing the F4 key will 
return the screen view to normal.  Also the F4 key will toggle between the full screen and the 
normal view. 

The Logbook icon opens the HRD Logbook display.  

Clicking the Satellites icon opens the Satellite tracking module.  

For those who are SWL fans, HRD contains an optional SWL Frequency Database.  Pressing the 
SWL Data icon opens a floating window that contains this database. 

The Sliders icon is a toggle that displays or hides the slider controls located on the lower 
portion of the Rig Control Display. 

The Customize icon allows you to customize the radio display by adding or removing buttons 
and sliders from the display.  It also allows you to change the font and colors displayed for the 
buttons. 

Options opens the options menu for HRD Rig Control. 

The Forums icon opens your web browser to the HRD Software Support Forums. 
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Program Icons 
We have closed the Main icon toolbar and opened the Programs Toolbar.  If you did not 
configure the Radio Setup Screen to automatically open these programs when you run Ham 
Radio Deluxe, you can now open them from here by clicking on the program icons. 

For those who would rather have the extra space on the display and use the Text Menus to 
access the features, the icon toolbars can be completely hidden by removing the check marks 
from all the options when right clicking on a blank portion of the toolbar. 

 

Rig Control with Icon Toolbars Hidden 

The Rig Control module has many features and options built in.  We will first look at some of 
the features, on the layout, and how they work. 

Tuning The Radio 
The most obvious display is the digital frequency display.  There are several ways to adjust the 
frequency using HRD Rig Control. 

Mouse Wheel:  When you place your cursor on a digit in the display and  rotate the mouse 
wheel in the digit is incremented/decremented depending on the scroll direction 

Up/Down:  The up-arrow, down-arrow,  + and - keys increment/decrement the active digit.  
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Mouse-click:   Select a digital by clicking over the digit. To increment / decrement click above / 
below the center of the digit.   Holding the mouse button down will increment/decrement the 
digits continuously.  

 Direct Entry:   To enter values by placing your cursor on a digit and press a numeric key (0-9). 
The active digital is updated and the cursor moves to the  next digit to the. 

 

Tuning Bars 
You can also tune the frequency settings by using the tuning bars.  The ones shown in the above 
illustration are for the 20 meter band.  The upper tuning bar is for FINE tuning the radio.  If you 
place your cursor on the silver tuning indicator in the center of the top tuning bar, click and 
hold the left mouse button then slide the indicator to the right or left you will see the frequency 
numbers incrementing/decrementing according to which direction you move the mouse. 

You can also just hold the cursor in position on the center indicator and left-click and  you will 
see the tuning bar move under the mouse position to adjust the frequency. 

The upper tuning bar is for FINE tuning and only displays a segment of the, in this case, 20 
meter band.  The lower tuning bar is for COARSE tuning and displays the entire range of the 20 
meter band. 

On the right end of the upper tuning bar you will notice two very small icons.  
Clicking on the round dot brings up a menu where you can select the increment that 
each click of the mouse wheel will move the frequency indicator.   

Clicking on the lower icon allows you to select the width of the band segment displayed for this 
tuning bar.  In this case it is set to 1.0 Khz 

.       
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Buttons & Sliders 

 

What’s a radio without buttons.  One set of buttons on our HRD Rig Control display is the BAND 
SELECT buttons.  When a band button is pressed the rig returns to the last frequency and mode 
used on that band. 

BSP (bandspread) – when you press BSP a new layout is dynamically created. The current band 
is split into multiple segments, for example the 20m band (14 MHz – 14.350 MHz) can be split 
into 7 segments, each of 50 kHz. 

 

On the bottom portion of the display we have our slider controls.  In our case, with the Yaesu 
FT-857 we have sliders to control our RF Power on HF, 6 Meter, 2 Meter and the 70 Centimeter 
bands.  There are also sliders to control the Vox, Mike gains, DSP Cutoff filters and others.  The 
sliders you may have displayed could be different. 

Buttons, Buttons and more buttons.  On 
the upper right of the display are more 
buttons.  Most of these are toggle 
buttons to turn different options in the 
radio on and off.  A few present drop-
down menus to select options from like 
the CTCSS button which allows you to 
select the tone frequency used for 
repeater PL tones.  You can also turn the 

tones on and off by clicking on the Tone button on the right of the display.  The Mode button 
allows you to select a mode, such as USB, LSB, DIG, CW, FM, or what ever mode you wish to 
operate the radio in. 

As mentioned before, all these buttons may be different according to your radio and the CAT 
command set installed in the radio by the manufacturer.  All the buttons and sliders are 
however, configurable. 
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Customizing Your Layout 
From the menu click on TOOLS then come down to and click on CUSTMIZE LAYOUT or pressing 
the Ctrl+F8 keys brings up the menu to customize your HRD display. 

Schemes 
 

 

Customizing Menu 

The first tab on the display is Schemes.  Schemes are pre-defined customizations created by 
Simon Brown, the original author of HRD and by many other early HRD users.  There are four 
default schemes shipped with HRD: Scheme #1 - #3 and the System Default. The HRD team and 
the HRD users have created the other schemes. Special thanks to Danielle, from Northallerton, 
UK for creating some of the more popular schemes. 

Select a default scheme by pressing the scheme button (or select an entry and press Select); 
select one of the other schemes by double-clicking on the entry in the Schemes list. To save the 
current layout press Save – you will be prompted for a Scheme name. Use Rename and Delete 
to organize the available schemes. 
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Radio Layout 

 

Radio View Layout 

HRD is a data-driven program.  For each radio there is a table of supported commands and 
associated button / dropdown / slider names.  The layout order is more-or-less alphabetical.   
An early complaint was that the buttons positions were not user-definable; as a result the 
Layout window was designed.  Don’t be put off by the amount of information in this window – 
take it slowly and read the information here.  
 
Dropdown Button / CAT Command / Macros  
You can create new buttons - for example, to create a USB button from the Mode dropdown:  
Select an empty button position – the selected entry will start to blink (you can reposition this 
button later), Press Select (above the Save and Load buttons),  In the Configure Button Mapping 
window select Mode : USB and enter the text to appear on the new button, then press OK 
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Button Mapping 

 

Configure Button Mapping 

The previously empty button position now has a new value – USB!  
 
Hiding  
Hide dropdowns hides the dropdown buttons to the right of the layout window, releasing two 
columns where you can assign new button definitions. Hide status texts hides the three top-left 
meters (-1-, -2-, -3-) and the status text area underneath, releasing two columns where you can 
assign new button definitions. 
 
 Moving Entries Move the selected entry by simply dragging it with the mouse or by using the 
four arrow-buttons.  
 
Removing Entries To remove an entry either drag it into the Unassigned list or right-click on the 
button and select Clear from the popup menu. 
 
 Dropdowns Select the dropdown menu, and then simply drag an entry to an unused location in 
the display. If you drag to a location that already has a definition the current definition is 
removed, if a standard button it is returned to the unassigned list.  
 
Unassigned Entries in the Unassigned list are standard buttons that are not currently displayed. 
Simply drag an entry to an unused location in the display. If you drag to a location that already 
has a definition the current definition is removed, if a standard button it is returned to the 
Unassigned list. 
 
 Styles  
In the Buttons pane you define up to seven button styles, shown here in the Button Styles 
group. To assign a style to a button either:  Drag the style over the button, or  Click a style to 
apply it to the currently selected (blinking) button.  
Save / Load  
To distribute your layouts with other users of your radio model use the Save and Load buttons. 
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Button Customizing 

 

Customize Buttons 

When customizing buttons you can define:  Seven button color combinations,   the font,  and 
the button size.  
 
The default button size is small.  This is so that users with low resolutions such as 800 x 600 still 
have a usable configuration.  There are no rules when using the button size.   Select the size 
which pleases you most.  For the technical readers the button size is tied to the font size of the 
radio display form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point).  Changing the font 
size simply changes the font assigned to the form. 
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Faceplate 

 

Faceplate 

Background   These colors are applied to the background area of the display and to the transmit 
meters (if any) such as PWR, SWR and ALC.  

Status Window   The status window displays information which you cannot normally change 
using buttons or sliders in HRD. Typical examples are Scanning status, Split mode and Memory 
channels.  

Clock Position   The clock is displayed to the left, right or both sides of the band title. 
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Frequency Display 

 

Frequency 

If your radio supports simultaneous access to two VFO‟s (Kenwood, some Yaesu) then HRD will 
display two VFO‟s, otherwise just one VFO is displayed. First select the VFO you are updating – 
main or sub. The colours you can set are:  Background,  Frequency – the digits,  Active Posn – 
the bar above and below the current digit,   Inactive Posn – the bar above and below the other 
digit,  
 
The Font can also be set, use the Main > Sub and Sub > Main buttons to copy settings between 
VFO‟s.  
 
Dropdowns The dropdown buttons (Mode, Filter…) can be displayed at the top of the main 
frequency display. Select:  None (no dropdowns),   Mode (only the mode dropdown) or  All (all 
dropdowns).  
 
If Mode or All is selected you can check Add Border to add a border around the text. If All is 
selected you can check Include Title to add the Dropdown button„s title (if there is room). 
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Customizing Meters 

 

Meters 

The design aim of the bar meters was heavily influenced by a Sony stereo,  still giving fine 
service after some 15 years of abuse.  The Background and Text colours should be obvious. 
There are three graduation colors:  Bars: Low – the first bar color,  Bars: High – the color at the 
position set by the High Position slider,  and  Bars: Free – the color for the free (empty) bars.  
 
If you check Show peak reading the recent peak value is displayed.   When HRD is in TX mode 
the S Meter value is replaced by the value selected in the Main and Sub dropdowns,  the value 
you select must be displayed by HRD in the upper right hand corner of the display. For Kenwood 
radios the value to be displayed is selected with the meter slider or the individual buttons (SWR 
/ Comp / ALC / dB). If you check the Always update… option then the S Meter is updated when 
you change frequency – this results in slower performance. 
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Slider Appearance 

 

Slider Appearance 

If supported by your radio,  sliders are displayed at the bottom of the display.  Here you define 
the appearance of the sliders.  These colors are optionally applied to the sliders in the Advanced 
selection windows (select Advanced from the View menu). 
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Slider Layout 

 

Slider Layout 

Here you select the sliders to be displayed.  Define up to 6 layouts, for example one layout for 
SSB and another for CW 
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Tuning Dial 

 

Tuning Dial 

Here you define the colors, fonts and band button positions. 
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Program Options 

Accelerators 
From the Rig Control menu bar, clicking on Tools > Program Options, or pressing the F8 key on 
the keyboard brings up the main Program Options menu. 

 

The Accelerator tab is where we define accelerators for use with the Keyboard or with 
programmable interfaces such as the Griffin Powermate.  When you press Add the definition 
window is displayed. 
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First notice on the right are pre-assigned keys, therefore we cannot use those again.  As an 
example we will assume we want to assign the key combination Ctrl+Alt+W to the Tune button.  
In the Key field we would enter the letter W.  We would then click in the Alt and the Ctrl box.  
Near the bottom of the screen you see HRD Button with a tick in the radio button to the left of 
Text.  In that field we would enter the word Tune.  At this point the OK button becomes active 
so press OK now. 

 

After clicking the OK button you will return to the main screen and as you can see, you have 
assigned the Ctrl+Alt+W key combination to the Tune button in HRD.  Now, just click the Save 
to File button below the text screen to save your key assignment to a file. 
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Comms 

 

Comms 

Normally you will not have to change the default settings.  
Read timeout – serial port timeout.  

Switch off – some radios such as the FT-817 can be powered down using a CAT command. If 
this option is selected you are prompted to switch off the radio.  

Polling – to reduce CPU load for slower systems.  

Dual VFO tracking – if selected both VFO‟s are tracked on every refresh.  

 Refresh interval – the interval between consecutive refreshes of the display.  
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Com Port TX 

 

Com Port TX 

Some early ICOM radios do not support switching between TX and RX using CAT commands. 
The only way to enable computer controlled TX/RX this is by toggling a COM port pin. You 
require a special CAT cable if you select this option. 
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ICOM Calibration 

 

Icom Calibration 

ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is S1 and so on. As 
a S Meter unit is 6 dB the algorithm applied is to divide the returned value by two to get dB, 
then divide dB by 6 to get S units. Some radios such as the IC-706 have a different logic – use 
the Offset and Scale values to adjust the returned values so that the S Meter in HRD 
corresponds to the S Meter on your radio 
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Info: Modes 

 

Info: Modes 

Mainly for use by the HRD programming team, all modes for each radio are listed. For each 
mode the mapping to the internal HRD mode is shown. 
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Info: CAT Support 

 

Info: CAT Support 

Mainly for use by the HRD programming team, all commands are listed for each radio. Press 
Radio for a list of all supported radios. To display the commands:  
1. Select a radio,  

2. Press Viewer.  
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Internet 

 

Internet 

HRD is able to detect whether you have an Internet connection with 
InternetGetConnectedState(). Uncheck this option if you do not want Internet access. 
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Out Of Band 

 

Out Of Band 

Configure the optional sound files played when you tune in / out of band. 

Mouse Wheel 

 

Mouse Wheel 

Define the tuning step when rotating the mouse wheel over the active tuning bar. 
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Selection Window 

 

Selection Window 

Adjust the appearance and operation of the selection window.  Single-click – normally the 
Favorites tree folders are opened/closed with a double-click.  Check this option to enable 
single-click operation. Show numeric value – the Select Windows Advanced slider values are 
optionally superimposed on the slider. Show the Options icon – historical support for the 
version 2 advanced slider look and feel. 
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Skinning 

 

Skinning 

Select and install various skins.  Changes are applied immediately. 

Themes 

 

Themes 
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HRD uses the excellent programming library from Codejock Software to support 
toolbars, main window tabbing and docking pane options Docking panes are used for 
optional windows such as: Bandscope, Calendar, DX Cluster, Logbook, Selection, 

Shortwave Database and WinKey.  
 
Main Theme Select whichever visual theme you want – Office 2003 is an acceptable default.  
 
System Theme When you select Office 2003 or Windows XP for Menus and Toolbars you can 
select an optional System theme. 
  
Main Tabs If you have more than one main window open – for example Radio and Logbook – 
then the main tabs are a useful way of switching between windows. 

Updates 
 

 
Updates 

Select how frequently HRD reminds you to check for new updates. 
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Yaesu 
 

 
Yaesu 

This is a Special option for Yaesu radios. Due to firmware „features‟ in the FTDX-9000 it is 
necessary to wait up to 250ms after writing a command to the radio. With any luck Yaesu will 
fix this at some date in the future. 
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Audio Grabber 
On the HRD Menu bar, clicking on Tools > Audio Grabber opens a floating pane at the bottom of 
the Rig Control window. 

 

Audio Grabber 

With the Audio Grabber you can record and store incoming audio, from your radio,  in MP3 files 
using the MP3 tags to store information about the radio settings (or any other information you 
feel to be important).  
 

The illustration shows you have the standard 
recording buttons. From left to right:  
Record, Stop, Reset current recoding, Restart (close 
current file first), Browse for MP3 files.  

You also set a file limit – a downside of MP3 is that 
the tags are written at the end of the file when it is 
closed, so to avoid losing information in the event of 

an unexpected event it is best to use more, smaller files. 

You see there are five tabs along the top of the display.   

Record tab is the one currently showing.  Clicking on the Folder tab opens a dialog to allow you 
to select where the recorded file is stored.   
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Quality tab is where you select the bandwidth and quality.  Modern computers have more than 
enough CPU power to support a very high quality.  A bandwidth of 4.5 kHz is usually acceptable 
unless you are recording a WFM broadcast. 

Soundcard tab contains a drop-down box where you select the soundcard used for the 
incoming signal.  

Tags tab Here you see the values stored in the MP3 tags.  To change the default settings just 
type in a new entry over the old one and press the Apply button. 

 

While we’re looking at this floating pane, you will notice a “PUSH-PIN” in the upper 
right corner.  With the Push-Pin in the position shown, the associated pane is 
PINNED to the display.  If you click on this pin, it will turn on its side.  When the pin is 
pulled, the pane is “UN-PINNED” and will collapse to a tag at the bottom or side of 

the main display.  You will see this used in all modules in Ham Radio Deluxe. 

Audio Browser 

 

Audio Browser 

.   
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On the left are icons and definitions that are 
used on the browser.  A basic MP3 player is 
built into HRD, however you can select an 
alternate player such as the excellent 
Windows Media Player. Press Default to 
select the default player 

 

 

Use the From and To slider positions to select the part of the file to repeated over and over and 
over again. This is useful for determining exactly what the station was sending. Other Options 
The other options are:  
Copy – copy the selected files to another folder.  



 
50 

Delete – delete the selected files.  

Move – move the selected files to another folder.  

Rename – rename the selected file.  

Artist / Album / Title / Description – change the MP3 tags.  
 

View Menu 
 

Clicking on View on the Text Tool bar brings up the menu you 
see on the left.  The items listed inside the red box, starting 
with Main, are toggles for the Icon Tool bar.   

Clicking on Status Bar displays the status bar at the bottom of 
the main display. 

Clicking on Full Screen or pressing your F4 key toggles the full 
screen mode.  In the Full Screen mode you will not see any 
menus.  Pressing F4 will return to the normal view. 

Selecting Advanced opens the Selection Window to the 
Advanced options menu. 

Clicking Customize brings up a menu allowing you to access 
the Framework Themes window, customize the layout, and 
load the Default layout for the Rig Control Display. 

Color Schemes allows you to edit the schemes of the display 
and Layout size lets you select a small, medium or large radio 
display. 

Slider Controls allows you to edit and configure the sliders on 
the Rig Control display. 

We have save the Advanced Options and the Selection Window for discussion all their own. 
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Advanced Options 

 

The Advanced Options allows you to adjust commonly used radio controls from within the Rig 
Control program.  There are six tabs across the top of the window, each providing access to 
certain controls.  The tabs and controls will vary depending on the radio and manufacturer.  
Here we are connected to a Yaesu FT-857D. 

Audio Tab 
The Audio tab gives you access to five gain controls and the VOX delay settings. 

CW Tab 
The CW tab has sliders to adjust the CW Pitch, Sidetone Frequency and the CW speed. 

DSP Tab 
Access to the DSP High and Low Cutoff filter sliders 

Other Tab 
Accesses the Noise Reduction, Noise Blanker and the Speech Processor controls. 

Power Tab 
On this tab you will find sliders for, in our case, HF, 6 Meter, 2Meter, and 70Centimeter RF 
power settings. 

Customize Tab 
Allows you to customize, Page Layouts, Navigation Windows and Display Style. 
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Selection Window 
Clicking Selection Window or pressing the F10 keyboard key pins the Selection Window to the 
Rig Control display.  From the Selection Window you have access to ALL of the major menus 

and data managers available in one place. 

Bands 
We’ll start with the Bands menu.  What we see here are 
the default bands available in Ham Radio Deluxe.  The 
bands are defined, in the defaults, according to the 
Region.  There’s also a band definition that covers all 
frequencies included in the 160m to the 70cm bands.  The 
60m band is also defined. 

These bands not only define the frequency ranges for the 
bands but they also provide information for Rig Control to 
generate the Band Buttons displayed on the Rig Control 
display. 

These bands can be edited or custom ones may be 
created by using the Bands Manager.   

Bands Layout Manager 

 

From here you can also enable and disable the button 
displayed by checking or unchecking the Status check box.  
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For example, if you uncheck the 6m (default) band in the display and click OK the 6m (Default) 
band will no longer show up in the Band Menu. 

Edit A Band 
Highlight one of the bands and clicking EDIT, on the top menu, opens the band editor. 

In our example, we highlighted the 160 – 
10m (Region 2) band. 

As you can see in the sliding window, 
each band is defined using it’s From 
Frequency and it’s To Frequency.  These 
can also be changed if you were to select 
a band, say 10m, press the Edit key on 
the menu bar and you could edit the 
frequency range to suite your need.  This 
feature allows us to create CUSTOM 
bands, which will be discussed later in 
this section. 

If you choose to edit a frequency range 
for a band, select the band, click on Edit 
and the editor window will open.  
Change the frequency range in this 
window and click OK.  You will return to 
this Layout Editor.  To save the new 
changes you may have to grab the lower 
edge of the editor with your cursor and 

hold the left mouse button down and drag it downward until you see the OK and Cancel 
buttons on the bottom of the editor.  Click the OK button and your changes will be saved and 
you can close out of the editors.  Your changes will be reflected in the band in the band menu. 

Creating Custom Bands 
This next section will explain, in detail, how you can create CUSTOM Bands, which in turn will 
generate the band button on the Rig Control Display.  

Let’s use as an example you are a General Class operator.  You would like to create a 20 meter 
band and button that would only cover the frequencies you are permitted to use for Voice 
communications.   

According to regulations a General Class license holder can operate voice on 20 meters 
between the frequencies of 14.225 MHz and 14.350 MHz.  

To create our custom band, select BANDS from the SELECT screen, and select MANAGER. 
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Let’s assume you are in Region 1, so you want to make your custom button available when you 
select the Region 1 Bands.  Click on the Manager at this point,  highlight the 160m to 10m 
(Region 1) band and press EDIT on the toolbar. 

You’re now in the band editor, so now, you might want to grab the top or bottom and drag the 
window up or down to stretch it so you can see the OK and CANCEL buttons at the bottom. 

We will assume you don’t want to delete the current 20m frequencies, so click on the NEW 
button on the top of this editor. 

In the Define Frequency Range window opens enter the band 
title 20m Voice.  Move to the From field and delete the 
current entry.  Now enter 014.225.000 MHz.  This MUST be 
entered with the leading zero. 

Move to the To field, clear the window and enter 014.350.000 
MHz. 

Make sure the Enable box is checked and click the OK button. 

When you click the OK button you will return to the main editor and your new band will be 
located on the bottom of the list.  Now, highlight your new entry and click on the UP ARROW on 
the Toolbar until your new entry is below the current 20m entry. 

Now, you can choose to either leave the current 20m entry enabled and have 2 buttons on your 
display, or you can disable it by removing the check in the box in front of it and only your new 
button will be displayed.  

When your sure everything is correct, click the OK button and your addition will be saved in the 
bands list and a new button will appear on your Rig Control Display. 

 

New Button Displayed 

With this feature you can edit any band so only the frequencies are shown which are allowed 
by your License class.  You can then activate the Out-Of-Band alarms to notify you when you 
tune outside of your allowed frequency ranges. 
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Favorites 
The Favorites menu acts just like your radios memory 
function.  Within the Favorites you can create folders for 
your favorite bands then within each band folder you can 
enter your favorite frequencies or even create sub-folders 
for things like Nets you access or repeaters, or just about 
anything you would like. 

As an example, here we have 
opened the 2m folder, showing 
calling frequencies, and folders for 
Simplex, Repeaters, and 
Switzerland, each containing 
frequencies.  These names, folders 
and frequencies can all be changed 
using the Favorites Manager.  At 
the top of the Favorites are a 

couple commands.  The Close Folders collapses any and 
all folders you might have expanded.  The Show/Hide 
Markers function, when clicked on, places a marker on 
the Rig Control Tuning Bar to indicate each frequency 
contained in a highlighted folder.  This feature can come 
in very handy when trying to find your favorite Net 
frequency quickly.  Just open the band folder and click on 

the frequency or Network name, depending on how you have it set up, and your radio will be 
automatically tuned to that frequency. 
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Editing Favorites 

 

Favorites Manager 

Clicking on the Manager on the Favorites menu opens the Favorites Manager dialog box.  Basic 
instructions for creating top level sub-folders are included on the screen along with editing 
commands of Copy, Del, Edit and Move.  Notice the “X” in the box to the left of each folder.  By 
clicking on and removing the “X” you can disable the folder.  When disabled (the “X” removed) 
the folder will not appear in the Favorites Menu. 

Edit A Folder 
In our example we are going to add a new frequency to the 2m folder.  
To do this, we double left-click on the folder to open it.   

Since we want to ADD a new frequency to the 2m folder, clicking on the 
ADD button opens the Editor window. 
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Once in the Editor window we enter a Title for 
our new frequency.  In this example we have 
entered the callsign of a local repeater 

Next we drop down and enter the frequency.  If 
you are entering a frequency such as 14.070.00 
it must be entered as 014.070.000.  If you have 
completely cleared this field before entering 
the frequency, it will only allow you to enter the 
digits and when you move your cursor outside 
the field the MHz will automatically be added. 

We now use the drop-down arrow to select the 
mode, in this case FM.  Now, press the OK 

button. 

When you press the OK button in the Editor, you will be returned to the 
Manager screen and you will see the entry we just made has been added.  
If by chance the new entry is not in the proper position in the list,  using 
the up and down arrows on the Managers tools can move it into the 
position where you want it within the folder.  All that is left now is to 

press the SAVE button on the bottom of the Manager screen and your new entry will be saved 
to the Favorites menu.  When you press Save, a window will open and ask you if you would like 
to overwrite an existing file.  Select YES to save the file used by HRD.  After you save the edited 
file, if you would like a back-up copy, you could navigate to a different drive, folder, or 
whatever and save an additional copy incase something should happen and the original would 
have to be replaced. 

Now, just click the OK button on the Favorites Manager to exit and return to the normal screen.  
You will now see your new addition in the 2m folder on the Favorites menu.  When you want, 
just open the 2m folder, click on the N3TWT icon and the radio will automatically tune to that 
frequency and change to the FM mode. 

This same procedure is followed to add new folders to your favorites.  Just remember, a new 
folder will NOT be saved to the favorites menu unless there is at least ONE frequency entered in 
it. 

Quick Save 
This is a simple way of marking a frequency as being interesting – you are monitoring three 

QSO‟s with a single radio and you want to quickly switch between the frequencies – for 

example during a 6m sporadic-E opening. Each definition consists of the frequency in Hertz and 

mode; definitions are saved in the registry. To switch between Quick Save definitions use the 

accelerator key combinations for the Quick Save menu options Next (Ctrl+F5) and Previous 

(Ctrl+F6). 
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Add Entry  
Select Add from the Quick Save menu or just click the Quick Save button. An entry is added to 
the Quick Save pane in the Selection window. 

Markers  
To display markers in the HRD display select Show Markers from the Quick Save menu. The 
marker size is selected from the Marker Size option in the Quick Save menu.  
The popup text is displayed as you move the mouse pointer over a marker. The text is 
constructed from the frequency and mode. 

Macros 

HRD supports two types of custom definitions, CAT commands, and combinations of standard 
HRD input fields. Macros are selected from the Macros pane in the Selection window 
 

Cat Commands 

A CAT command macro is a command that you define 
yourself, containing one CAT commands as describer in 
your radio’s handbook. The commands you enter must be 
supported by your radio. Use CAT commands to add 
support not provided by the HRD interface.  

Cat Command Manager 

To enter the Manager, either press Manager in the Macros> CAT Commands pane or select CAT 
Command Manager from the Macros menu. 

 

Cat command Manager 



 
59 

Pressing the New button in the CAT Command Manager opens the editor where you input your 
new command definition.  

 

In this example a Kenwood command is defined for the TS-480.  The mode is set to USB and the 
frequency to 50.150 MHz.  In the Title field enter ‟50.150 MHz USB‟.  

In the CAT Command field enter: # Set mode to USB MD2 

 # Set frequency to  50.150 MHz FA00050150000.  

 In the Description field enter “Change frequency to 50.150 MHz, mode to USB‟. 

Now press OK. The new definition is added to the list in the Manager window. 

Protocols 

Elecraft and Kenwood 

Each command consists of 2 alphabetical characters (lower or upper case) and optional 

parameters. Please read your operating manual for command information.  

The terminating semicolon (;) is not necessary, it is added automatically. 
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 TS-480  

Set mode to LSB .....: MD1  

Set mode to USB .....: MD2  

Set AF gain to 0 ....: AG0000  

Set AF gain to 100 ..: AG0100  

Select VFO-B ........: FT1  

You can define more than one command; to do this start each command on a new line.  

Special Commands 

Comment ..........: # Some interesting text. Pause of 250 ms ..: @ 250 

ICOM 

ICOM radios use the CI-V format to communicate with the radio. Please read your operating 

manual for command information. Each entry defined here consists of: 

[1] command 

[2] optional sub-command and 

[3] optional data. 

You must add a - between each byte (each byte is two hexadecimal characters).  

IC-7800  

Set mode to LSB ..........: 06-00  

Set mode to USB ..........: 06-01  

Set AF to 0 ..............: 14-01-00  

Select preamp 2 ..........: 16-02-02  

MOD I/P (data off) MIC ...: 1A-05-00-31-00  

MOD I/P (data off) SPDIF .: 1A-05-00-31-07  

You can define more than one command; to do this start each command on a new line.  
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Special Commands  

Comment ..........: # Some interesting text.  

Pause of 250 ms ..: @ 250 

Ten-Tec 

In general Ten-Tec commands are two character commands followed by data and a carriage 

return <cr> or <0x0d>. Do NOT add the carriage return - this is added automatically. Some data 

must be sent in binary format, hexadecimal is used to represent binary data. To set Split mode 

on for the Argonaut the documented command is *O<0x01><0x0d> which is entered here as 

*Ox01, that is *O (Split mode) + x (switch to binary) + 01 (Split On). The carriage return <0x0d> 

is not added. Please read your operating manual for command information. When you enter x 

the format switches to binary mode - two hexadecimal characters per byte. Only enter x once, 

even if entering more than one byte of data. Argonaut  

Set mode to LSB .....: *M2  

Set mode to USB .....: *M1  

Set split mode on ...: *Ox01  

Set split mode off ..: *Ox00  

Jupiter  

Set mode to LSB .....: *M2  

Set mode to USB .....: *M1  

Set AF gain to 32 ...: *Ux20  

Set filter to 450Hz .: *Wx1D  

You can define more than one command; to do this start each command on a new line. 

Special Commands  

Comment ..........: # Some interesting text.  

Pause of 250 ms ..: @ 250 
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Yaesu 

Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very similar to that 

used by Kenwood. So if you are fortunate enough to have the FTDX-9000 please use the 

Kenwood commands – see Elecraft and Kenwood. 

Each Yaesu command consists of five bytes. The bytes are defined in the order in which they 

are sent to the radio. You must add a - between each byte.  

Each command consists of four bytes of data and an OpCode. The order in which P1-P4 are 

shown in your operating manual does not matter here - there are difference between Yaesu 

radios, just remember that the bytes are defined in the order in which they are sent to the 

radio. Please read your operating manual for command information.  

FT-817  

Set mode to LSB ..: 00-00-00-00-07  

Set mode to USB ..: 01-00-00-00-07  

Split on .........: 00-00-00-00-02  

FT-1000MP  

Set mode to LSB ..: 00-00-00-00-0C  

Set mode to USB ..: 00-00-00-01-0C  

Split on .........: 00-00-00-01-01  

You can define more than one command; to do this start each command on a new line.  

Special Commands  

Comment ..........: # Some interesting text.  

Pause of 250 ms ..: @ 250 

Macros: Default 
This option allows you to create macros that are similar to 

the Favorites.  The difference being with this tool you can 

set a frequency, mode, RF Power, Filters, and other 

parameters then take a “Snapshot” and automatically 

generate the macro. 
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Snapshot 

Let’s use as an example, you have a local repeater that operates on 147.120.000 MHz.  First, 

Tune your radio to that frequency and set the mode to FM.  Since the repeater is close to you, 

you only need 5 watts of power to access it, so we set our 2-meter power to 5 watts.  We know 

this repeater requires a PL tone, so we set the CTSCC tone to Encode. 

Once you have the settings correct, you click on the “Take Snapshot” option. 

Our Snapshot window will open.  Here you can change 

the GROUP to one you already have or add a new group 

by typing over the text in the Group field.  In this case, 

we will leave the group set to default. 

Click on the OK button and your macro will be created in 

the Macro: Default group. 

When you select this macro in the future, it will 

automatically set up the parameters you have set and all 

that remains is you clicking on the CTSCC button on your main display, select the PL tone used 

and click on More. 
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Create HRD Archive 
On the Rig control menu bar, click on Tools and select Archive from the drop-down menu. 

 

This dialog box allows you to create a full archive of your HRD data folders and also creates a 

backup of all the Registry Keys used by Ham Radio Deluxe.  This option comes in handy in the 

event you have a hard drive crash and have to re-install your software.   

The From: folder is automatically selected in the utility window. 

The To: folder is user selectable.  It’s recommended you choose a location not on your main 

drive, such as a flash drive or external hard drive. 

Once these items are selected, click the Copy button at the bottom of the window and your 

archive will automatically be created. 
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HRD Archive Directory 

Tune-Up 
A Tune-Up function is available from the Tools 

menu on the HRD Rig Control screen.  This 

allows your radio to be switched to Transmit 

to allow your antenna tuner to adjust the 

SWR. 

Select a mode, such as AM or CW, (selecting 

AM normally reduces power to 25 watts on 

most rigs).  You can then select a timed 

interval for keeping the transmitter keyed, or 

you can select continuous, which keys the 

transmitter until you manually un-key it.  You 

can also select the RF Power with the slider on 

the display. 
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Voice Synthesizer  
Selecting VOICE on the toolbar opens a menu that allows 

you to enable or disable the built-in Voice Synthesizer.  It 

also allows you to select from the list the item/items you 

would like to have a voice announcement made for. 

 

 

 

Scanning 
The Scanning tool allows you to choose how you would like a scan to 

be performed.  It allows you to set a frequency range within a band, 

or allows you to select the entire band to be scanned. 

The Scan Frequencies option allows you to import frequencies from 

your Favorites list.  An example would be if you have many local 2 

meter repeaters in your area and have them programmed into your 

favorites list,  they could be loaded into the frequency scanner 

window which would then allow you to scan your entire list of 

repeaters for an active station. 

HRD Global Settings 
Tools > HRD Global Settings opens the settings screen. 

 

Here you can adjust for simplified menus or an advanced menu system.  Also in Preferences, 

you can set the programs to show Miles vs Kilometers, F vs C temperatures, etc. 
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